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Section 1: MetaBot Designer - Getting Started
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1. AAE Client MetaBot Designer Overview
A MetaBot is a highly re-usable automation blueprint of an application. This automation blueprint can be constructed using:

l Visual captures - These are GUI components (screens) of an application.

l In MetaBot Designer, a visual capture is referred to as Screen.

l Application APIs - These are interfaces that allow low level operations of an application by circumventing GUI.

l The MetaBot Designer also supports the most common format of API on Windows platform – the DLL.

l Navigational flows - These are pre-configured use cases of an application and leverage Visual captures and APIs.

l In MetaBot Designer, Screens and DLLs form the Assets using which you can define and pre-configure any use case of a
target application to create a navigational flow, known as Logic.

Learn More

Benefits of using MetaBots

Using MetaBots in automation tasks have the following benefits:

l MetaBots are highly re-usable; create once, use everywhere. They show up in automation command library in AA Enterprise and
can be leveraged by any automation task.

l Enterprises can leverage MetaBot library to standardize org-wide automation in a rapid manner.

l MetaBots ensures systematic, accelerated automation ROI.

l MetaBots help to eliminate common navigational errors in complex automation tasks.

l MetaBots help to automate without requiring access to live application

l MetaBots can be easily calibrated to newer versions of applications to ensure compatibility.

The MetaBot Designer

The MetaBot Designer helps you to conceptualize, create, manage and upload MetaBots.

With MetaBot Designer, you can:

l Create MetaBots.

l Add Assets – Screens and DLLs to your MetaBots.

l Manage your MetaBot Assets.

l Configure and Calibrate the Screens.

l Create custom objects on the Screens.

l Create Logic to represent a navigational flow using Screens and DLLs.
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l Upload the MetaBots to the Control Room for use by other Enterprise Client users.

l Edit MetaBots created by other users.

l Export and Import MetaBots for use in different Control Room setups.

Installing the MetaBot Designer

The MetaBot Designer comes pre-installed with Automation Anywhere Client.

To access MetaBots, the Client user has to have the required access privileges that are provided by the Control Room administrator.

l To do a quick check that MetaBot Designer is installed and working fine, ensure that you see MetaBots under AUTOMATE on left
panel.

l Click on MetaBots tab to launch the My MetaBots view. 

l If you are using MetaBots for the first time, the list does not display any file. You can simply start creating MetaBots using
either New or Record option. Learn More

l However, if you have upgraded to the current version, you will see MetaBots created in earlier version(s) listed under My
MetaBots.

l To access the MetaBots Designer console, you need to click on Edit. Learn More

Launching the MetaBot Designer

After successful installation of Automation Anywhere Client setup, the feature is added to the product under the Automate Tab.

Note: You will have to exit and restart Automation Anywhere Client for the changes to take effect,
if you have upgraded to the current version.

Click on 'MetaBots' to launch the Enterprise Client - MetaBot Designer.

Understanding Enterprise Client - MetaBots

A BotCreator Client with MetaBots Repository access permissions can create, record, edit, upload, download, and rename MetaBots
from the Client - My MetaBots list view.

From the Enterprise Client - MetaBots view, a BotCreator can create a new MetaBot, record screens for a new MetaBot, upload and
delete MetaBot(s).

Additionally, if Version Control is enabled for controlled edits of MetaBots, a BotCreator can Check Out the MetaBot for editing and
view Version History. Learn More
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From the My MetaBots list view, a BotCreator can perform the below actions:

1. New - Use this to create a New MetaBot. Learn More

2. Record - Record is an alternate method of creating a MetaBot. Learn More

3. Upload - Upload the MetaBots to the Control Room to enable other BotCreators to download for TaskBot integration. Learn More

4. Delete - Use this to delete obsolete MetaBots or ones that are no longer required. Learn More

Some of these features are also accessible from the MetaBot Designer console. Learn More
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2. Understanding MetaBot Designer

Using the MetaBot Designer, you can:

l Specify folders in an existing MetaBot,

l Add DLL's to create low level operations of an application by circumventing GUI

l Add and record new screens to a MetaBot;

l Create simple independent yet functional logic blocks.

l Also, create MetaBots and upload them to Control Room to create a repository for using/reusing MetaBots in automation tasks.

MetaBot Designer Decoded

The work space in MetBot Designer allows you to work with multiple MetaBots at the same time. MetaBots that you wish to work on can
be kept open in the form of tabs.

Once you create a MetaBot, you are taken to Assets tab by default where in you can start by adding new assets (Screens/DLLs).
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Understanding Assets

The following explains the options available within an Assets view:

1. MetaBot Tab - The MetaBot opens in its own tab. This tab is dedicated to the Assets and Logic for that particular
MetaBot.

2. Assets Tab - When highlighted it indicates that the view is open in 'Assets'; it displays all the Screens, DLLs and
Folders inherent to this particular MetaBot. It is selected by default for a new MetaBot.

3. Add Folders* - You can organize your MetaBot using 'Folders'. This will enable you to easily manage all your
screens and dll's that are to be uploaded/have been uploaded.
Learn More

4. Add Screen* - When you require to capture a single screen for an application executable that is running, this feature
is extremely useful.
Learn More

Note: You will have to invoke the application screen before using this feature.
Also, if the application is closed, you will be prompted to open the required applic-
ation.

*If your Screens are set at lower resolutions; e.g. 1024 X 768, the 'Add Folder' and 'Add Screen' options can be
accessed from the 'Edit' menu.

5. Record Screen - When you need to capture multiple screens of the related application/webpage at one go, use
Record Screen. Every screen / Menu item / Popup / context menu that you interact with during the recording gets cap-
tured.
Learn More

Tip: Use Record Screen to record all the Screens/UI elements (Menu item / Popup /
context menu etc.) while you interact with the application in a workflow mode. These
UI elements cannot be captured using Add Screen.

Note: If an application has multiple exe's, you are required to create a separate
MetaBot for each.
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6. Add Dll - If you need to use an 'Application Programming Interface’ (DLL) within your MetaBot, you can add it to the
MetaBot using 'Add Dll'. Remember though, you cannot include special characters in DLL names.
Learn More

Note: The Screens, DLLs and Folders are displayed in the order they were added.

7. Configure - Use this to edit properties for the recorded/added screen. Here you can provide aliases such as a
'Screen Name' and a 'Screen Title'. You can also select an object to define its properties such as Name, Path, Value,
ID, Class, Index, States etc and the 'Play Mode' to be used when running tasks. Some of these properties help to
uniquely identify an object during playback. You can thus use configure to improve the reliability of your automation.
Learn More

8. Calibrate - Since an application may get updated continually during its lifecycle with improvements and newer fea-
tures, your captured screen and its object properties might need a re-look after every update of the application. In
MetaBots Designer you can use ‘Calibrate’ to instantly compare an existing screen with a newer screen to identify
changes if any.
Learn More

9. Upload - The MetaBots can be 'uploaded' to the Server i.e. uploaded to the Control Room, which acts as the central
library from where fellow MetaBot Designers can pick up the MetaBots necessary to their task(s). The client with
MetaBot privileges can upload and deploy the MetaBots to the server.
Learn More

10. Delete - Use this to delete MetaBots that are no longer required.

Note: Deleting a MetaBot from the MetaBot Designer doesn’t delete it from Control
Room.

Once you have captured the desired assets, move on to create Logic using those assets.
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Understanding Logic

A Logic is an independent yet functional unit of a process that represents a part navigational flow of an application and
can be integrated into automation tasks as and when required.

You can use Assets (Screens and DLL's) to design a Logic block. Subsequently, you can upload the Logic Blocks to
Control Room so that they can be downloaded to Development/Runtime Client(s) with appropriate MetaBot privileges.

The following explains the options available within a Logic view:

1. MetaBot Tab - The MetaBot opens in its own tab. This tab is dedicated to the Assets and Logic for that particular
MetaBot.

2. Logic Tab - When highlighted it indicates that the view is open in 'Logic'; it displays all the Logic Blocks and Folders
inherent to this particular MetaBot.

3. Add Folder - Similar to Assets; for instance, you can add Logic Blocks that are functionally similar to a folder.

4. Add Logic - Use this to create your navigational flows in the Logic Editor.
Learn More

5. Record Logic - Use this to record the logic flow and automatically save Screens in Assets.
Learn More

6. Edit - Use this to edit an existing navigational flow.

7. Upload - Use this to publish (upload) your (new or edited) Logic to the Control Room.
Learn More

8. Delete - Use this to delete obsolete Logic.

Note: The Logic and Folders are displayed in the order they were added.
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3. Creating a MetaBot
Let’s create your first MetaBot. It will allow you to login to your Automation Anywhere account.

1. Open the MetaBot Designer and click on New.

2. A smaller window, called New MetaBot, opens.

3. The New MetaBot window lists all the currently running applications. From this list, select an application (Internet Explorer in this
case) for which you want to create a MetaBot. Type in a name - “MyApp_MetaBot” for instance and click on Create.
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Tip: If you forgot to launch the application before starting to create a MetaBot for it, just
open it now and click on Refresh on the New MetaBot window. Your application will appear for
selection in the list.

4. This creates and opens a new but empty “MyApp_MetaBot”. It cannot do anything for you yet.

5. To Login to “MyApp” your Automation Anywhere account, we need its screen asset. Click on 'Add Screen'.

6. On the center of your screen, a small window called 'Open Screens' is displayed. This window will list all currently open instances
of the target application for you to select.

Note: If you have two instances of IE open - as is the case here, you will see two separate
screens displayed in 'Open Screens'.

7. Click on the Windows Internet Explorer screen instance “What can automation do for you?...” to proceed.

8. The selected screen gets added to your MetaBot.
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9. The next logical step would be adding more screens to your Assets library. Use either the 'Add Screen' or 'Record Screen' option.
Learn More.

10. Let's add another screen to Assets. This screen will be used to add credentials.

11. Let’s use these screens to create a logic to login to your account. Click on Logic tab.

12. Click on Add Logic.

13. This opens a large window called Logic Editor, a place where you define the navigational flow by selecting screens/dlls, add com-
mands, define logic, save and play the flow to see if it works as expected.

14. Click on 'Login' in the screen that was captured first. This will open a 'Properties' window near the selected object that will allow you
to configure 'Actions'.
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15. Select either 'Click' or 'LeftClick' from the drop-down.

16. In Advanced Options input the Wait time for the object to load. Enable 'Show Object Properties' to view the properties that will be
used to search the object during play time.

If the selected object has dynamic properties in its search criteria, it is recommended to use '*' in place of the actual value. For
instance, in the above, change the value of property 'HTML ID' as shown:

To know more refer Configuring MetaBot Screens.

Tip: If no name is displayed for the selected control, you can give an easily identifiable
name to it. Learn More.

17. Subsequently, add other screens by clicking 'Next'. For instance, the above action will navigate you to the login screen wherein you
have to input your credentials:
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18. If your Logic requires that you add commands, select ones that are most appropriate for your logic. Learn More

19. If needed, you can also add DLLs. Learn More

20. Once done, click on Save.

21. You will be prompted to enter a name for this new logic that you just created. Name this logic as “Login to MyApp”. Click on Save to
finish.
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22. The saved actions will appear in the Logic Editor under the Actions List.

23. Let’s run this logic to see if it works as expected. Click on Run.

24. Yay! You have successfully created a MetaBot with a logic to login to MyApp - your Automation Anywhere account.

25. We will now use this Metabot in an automation task. Assuming Automation Anywhere Enterprise Client is also installed on your
machine and supports MetaBots, open Task Editor to create a new automation task.

26. Select the 'MyApp_Metabot' from the list of MetaBots on the top left and drag it onto the task action list.

Note: These are available after the MetaBots have been Uploaded to the Control Room and later
Downloaded to the Client.

27. This invokes the MetaBot UI where you can browse and select from the list of available Logic. Select the MyApp logic and click on
Save.
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28. The logic gets added to your task.

Tip: If you specify any input/output parameters while creating a logic in the Logic editor,
you can see them here. We didn’t use any input/output parameters while creating “MyApp_Login”
Logic. So you will find the parameter selection disabled. Learn More

29. Save the task and run.

Tip: You can launch the website first and then use the “MyApp_Login” logic.

30. You have successfully used a MetaBot to login to your Automation Anywhere account.
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4. Adding and Recording a MetaBot
You can create MetaBots using the MetaBot Designer either by adding an empty MetaBot or recording a series of steps of a workflow.

Creating a New MetaBot

This creates an empty MetaBot for the selected application. You can then progressively add screens to this MetaBot at any point of time
using Add Screen and Record Screens.

Step by Step Guide to Creating a MetaBot

Creating a New MetaBot using 'New'

1. Click New MetaBot

2. Select an application that you wish to create a MetaBot for. Specify the name that reflects the purpose of creating the Metabot.

Note: Click 'Refresh' if your application is not listed. Alternately, despite 'Refresh' if it
is not listed, verify if the application is running in 'Admin' mode. If yes, restart the MetaBot
Designer in 'Admin' mode.

3. Click Create to save the MetaBot.

l The MetaBots are saved in the My Documents folder. You change the location to save your Metabots in the AAE Menu Tools >
Options > System Settings.

Creating a new MetaBot using 'Record'

You can also create a new MetaBot by capturing the entire process in sequence.

Recording is especially useful when you want to capture a workflow. Here, you can opt to

l Record only screens
or

l Record screens with the workflow in the form of logic.
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1. Record Screen(s)

Use this option when you want to capture only screens with relevant object properties.

1. Click record

2. Specify the application from which you wish to capture GUI properties.

3. Select 'Record Screen(s) option in the Record MetaBot window.

4. Click on the image in Open Screens.

l MetaBot Designer begins recording the selected screen of the application:
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Note: Each click will record the screen.

l You know you are in recording mode when you see:

5. Click 'Pause' if you wish to stop recording for sometime but resume from where you left off.

6. Click 'Resume' to continue recording:

Note: If an application has multiple exe's, you are required to create a separate MetaBot for
each.

2. Record Screen(s) with Logic

Use this option when you want to save the workflow in the form of Logic directly instead of configuring, calibrating and then designing a
logic flow. This will also add recorded screens to the Asset library.

Follow Steps 1 through 6. However, instead of selecting 'Record Screen(s), select 'Record Screen(s) with Logic:
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When you hit Stop, the Logic Editor is launched. Here, you can choose to edit the workflow and save as Logic.

Tip: You can also record logic with screens for an existing MetaBot using the 'Record Logic' option
in 'Logic' tab. Learn More

Adding Screens to a MetaBot using 'Add Screen'

Use this to capture a single screen for an application executable that is running.This will add a screen to the existing MetaBot.

To add a Screen,

1. Click 'Add Screen'

2. Click on Open Screens window to begin capturing:
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3. Wait for the Screen to capture:

4. The screen is added to the current MetaBot.

Recording Screens in a MetaBot using 'Record Screens'

Recording is especially useful when you want to capture a workflow.

Use Record Screen to record all the Screens/UI elements (Menu item / Popup / context menu etc.) while you interact with the applic-
ation in a workflow mode. These UI elements cannot be captured using Add Screen.

To record a Screen:

1. Click 'Record Screen'

2. Click on Open Screens window

3. The screens that are captured are saved to the current MetaBot

Tip: It is recommended that you keep the zoom level of your screens to 100% while creating, record-
ing and playing your MetaBots.

Updating MetaBots

Update your MetaBots by adding to or modifying the existing one. You can add/record screens, add dll's, folders and re-upload to Con-
trol Room. You can re-configure and re-calibrate captured screens.

i.e. carry out all functions that you would when creating a new MetaBot.

Deleting MetaBots

You can delete a MetaBot or Screens and/or Dlls from a MetaBot.

Delete in one of the following ways:

1. From the 'Edit' menu:
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2. Using 'Delete' button:

Note: You can verify whether the 'Screen' to be deleted is used in multiple logic from a 'Logic
List':
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4. Renaming MetaBots
To rename a MetaBot, follow these steps:

1. In the 'My MetaBots' List that is available in the Automate tab of the Client, select (highlight) the MetaBot you want to rename.

2. Rename the MetaBot using one of the following methods:

l In the File menu, select Rename.

l In the Actions button, select Rename from the drop-down list.

l Context click the MetaBot and select Rename.

Tip: Ensure the MetaBot is closed in the MetaBot Designer Client. Also, note that if the cor-
responding MetaBot is the only MetaBot that is opened in the MetaBot Designer while renaming, you
need to exit from the MetaBot Designer Client.

1. In the Rename File window, specify a new file name for the MetaBot.

2. Click Save.

The renamed MetaBot is displayed in the My MetaBots List view.

Renaming Existing MetaBots

You must ensure while renaming MetaBots that they are not present in the Control Room. When you attempt to rename a MetaBot in
the Client that already exists in the Control Room, following message appears:
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Also, MetaBots that are renamed from a file system cannot be reuploaded to the Control Room repository. If you attempt to upload such
a MetaBot from the Client, following message appears:

When you upload the renamed MetaBot(s) from the Repository, following messages appear:

l For a MetaBot:

l For multiple MetaBots:

You will have to revert to its original name in order to upload it.
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Renaming MetaBots if Version Control is enabled

Applicable to Enterprise Client - MetaBot Designer edition 10.3 onward

You can rename a MetaBot in the local repository. However, note that if you rename a MetaBot and upload to the repository, it will over-
write the existing MetaBot with the previous name. The version history will be lost in such case.

l When renaming a file that has been uploaded to the server repository, you will be prompted:

l If the file is checked out for edit, you will be prompted a message as only the local MetaBot version will be renamed :

Tip: Undo Check out to rename the MetaBot.
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4. Deleting MetaBots
In some cases, you might want to delete an existing MetaBot.

To delete a MetaBot, follow these steps:

1. In the 'My MetaBots' List, select (highlight) the MetaBot you want to delete.

2. Delete the Metabot using one of the following methods:

l In the Edit menu, select Delete.

l In the Actions button, select Delete from the drop-down list.

l Context click the MetaBot and select Delete.

Tip: Ensure the MetaBot is closed in the MetaBot Designer Client. Also, note that if the cor-
responding MetaBot is the only MetaBot that is opened in the MetaBot Designer while deleting, you
need to exit from the MetaBot Designer Client.

1. In the Delete MetaBot? window, click on Yes.

l The MetaBot is removed from the 'My MetaBots' List view.

Note: After deleting a MetaBot, you cannot restore it in the Client. Before deleting a MetaBot,
ensure you no longer have use for that MetaBot.

Tip: As a best practice, ensure all MetaBots are copied to the Control Room repository as a way of
backing up your MetaBots.

Deleting a MetaBot if Version Control is enabled

Applicable to Enterprise Client - MetaBot Designer edition 10.3 onward

If you have version control enabled, while deleting the MetaBot from the Client, apart from confirmation, you will be notified that it will
be deleted locally only.

 Note: To delete the MetaBot from the Control Room repository, you will have to select it from the
relevant folder of the repository.
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5. Configuring MetaBot Screens
Essentially, you need to create MetaBots in such a manner that they cover all possible run time scenarios. This will ensure that the
tasks in which they participate run without any glitches. Thus, simply capturing a screen may not help in most cases. This is where the
Configure feature comes into picture.

Use 'Configure' to edit object properties for the recorded/added screen. Here you can provide aliases such as a 'Screen Name' and a
'Screen Title'. You can also select an object to define its properties such as Name, Path, Value, ID, Class, Index, States etc and the
'Play Mode' to be used when running tasks.

The object properties have a very important objective. A set of these properties help to uniquely identify the associated object during
playback. As you would have noticed, the product intelligently selects some of these properties by default for every selected object to
get you going through most of the scenarios. However, for complex cases, you can always play with these properties to make your
MetaBots truly reliable. For instance, you can customize certain objects using the 'Custom Object' option.

Guide to Configuring a Screen

1. Select a screen.

2. Click Configure to launch the Screen Configuration editor

3. Highlight the control which you wish to use during run-time.

l The object properties are populated in the right panel of the screen.

4. Optionally, provide a Screen Name.

Note: Screen name is the name that we provide to the added screen, while screen title is the
one that appears on the screen window that is configured.

l You can rename the Screen if you feel that it would be easier for a user to identify with something else.
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l Also, it is recommended that you provide a generic screen title to ensure compatibility with all situations

Note: Use ' * ' to add a generic title.

5. To customize the view type of object that has been captured, select any one from the list:

l Custom Objects are the ones that you define especially when the object properties are not captured while record-
ing/capturing a screen. Simply drag and select the area; choose whether to treat the object as Push Button, Text Box, Static
Text, Link or Image.

When custom objects move or are re-sized, you will have to update relevant Screen(s) to reflect the same. You can achieve
this by moving and/or re-sizing those during configuration.

l To move the customized object to a different location, click and drag it to the target location.

l To re-size a customized object, hold down the click button and drag the pointer as required.
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l Co-located Objects are the ones that are neighboring to the currently selected object belonging to the same parent control.

6. The Object List is populated as per the View selected.
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7. In the Selected Object Details panel, you can optionally specify an alias in the Name text-box for the same reason as renaming
Screen/Title names.

Note: Here, 'Name' is the selected object name. Specify user friendly / easily identifiable
name for the object. This is helpful when you use this screen in a task for automation.

8. Select a Play Type - whether Object, Image or Coordinate.

Note: Observe that the play type is enabled automatically depending upon the selected object
type. You may however select the one that suits the purpose of the Logic.

l Object - Use this as the play type for object selected on the basis of its object properties. This could be useful when the
selected object are dynamic in nature; in the sense that they keep shifting their positions in the target application.

l Image - Use this as the play type for objects selected on the basis of its image properties. This could be useful when the
selected object might shift in the target application.

l Coordinate - Use this as the play type for objects selected on the basis of its coordinates properties. This could be useful
when selected object is available at the same co-ordinates in the target application.

9. Select Properties type that you wish to use during play time. You can choose to view select properties or view them all. Some prop-
erties are selected by default.

You can also change the Values of the properties, if required to make your MetaBots more reliable.

Note: Properties could differ depending upon the type of object/control captured.

10. Save when you have all screens covered for configuration.

Tip: Use the 'Previous' and 'Next' buttons to access other screens in the MetaBot without exiting
Application Calibration.

and
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6. Calibrating MetaBot Screens
An application can undergo continual change during its life-cycle with improvements and newer features. MetaBot Designer's Cal-
ibration feature allows you instantly compare an existing screen with newer screen to identify those changes.

With a single click you can then upgrade the existing screen and upload it so that all the automation tasks using that screen can lever-
age the newer features.

Guide to Calibrating a Screen

1. Select a screen.

2. Click Calibrate to launch the Screen Calibration editor

l The calibration screen is divided into two panels: The one on the left - Calibration Source indicates your current screen
(which needs to be calibrated) and one on the right Calibration Target (usually the latest screen) .

3. In the Calibration Source panel, the screen that has been selected from the Metabot is displayed.

4. In the 'Screen to be Calibrated' panel select the control that requires calibration and hit 'Calibrate'.

l You know the Calibration is successful when you encounter:

Note: You cannot calibrate screen that pop-up or do not have a title.

l The properties displayed under the screens are calibrated accordingly and displayed in the 'Calibration Result' panel:
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Here you can choose to view calibration in four 'Views':

Note: MetaBot Designer provides you quick summary (in numbers and percentages) of the
newly added objects, updated ones, missing from targeted screen and matching objects that
were found.

l Once you complete the calibration, you can actually compare the screens by clicking on the objects on either panes. The
objects will be highlighted accordingly. Any unchanged object will get highlighted in both panes. And if it doesn't get high-
lighted, it indicates a change between your current screen and the calibration source.

5. Save when done.

6. Next, you can opt to retain or overwrite existing screen if a newer one is detected. You can also choose to carry forward any
existing custom object, if configured.

Tip: Use the 'Previous' and 'Next' buttons to access other screens in the MetaBot without exit-
ing Application Calibration.

and
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7. Adding Folders to a MetaBot
You can bundle similar screens and Dlls together using folders. This will help you to logically manage MetaBots for ease of under-
standing and use.

i.e. Keep all the Screens/DLLs related to new employee record creation together in a folder "New Employee".

MetaBots can have any number of folders. You can also perform certain operations on a folder i.e. configure, calibrate, upload and
delete.

Note: You can add 'Folders' to 'Assets' and 'Logic'.

Guide to Creating a Folder

1. In the MetaBot Designer, click on Add folder

2. In the 'Add folder' window specify the folder name. Ensure that you use a name that reflects the type of folder created. Save by click-
ing 'Create'

l This is how a folder is displayed in the work-space window:

l Double click the folder to access related screens and dlls.

Note: Use the back button ( )if you wish to return to the main/previous window.

Moving Assets and Logic within Folders

You can move your Assets (Screens & DLLs) and Logic within Folders of a MetaBot.

l To move an Asset (even Screen or DLL individually) and/or Logic, simply drag and drop it to the target folder.
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l To move an Asset (even Screen or DLL individually) and/or Logic, a level up, select the option 'Move Up' in the context menu:

Remember - to move to a folder you need 'drag and drop' action; but to move a level up you require to use the context menu.
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8. Recording Logic
At times you may want to capture the workflow directly instead of creating Screens, configuring them and then manually designing the
Logic. To enable direct capture of workflow with Screens, you can opt to record Logic for an existing MetaBot.

Remember that to record logic for a new MetaBot, you will have to use the 'Record Screen(s) with Logic' option given in 'Record' from
the MetaBot Designer panel. Learn More

However, in order to record logic for an existing MetaBot, you will have to use 'Record Logic' from Logic section of the MetaBot
Designer.

This topic describes the second option.

How to Record Logic

1. Open the target application.

2. Choose an existing MetaBot; the one that is relevant to that application.

3. Go to the Logic tab, select Record Logic.
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4. Click on the image in the 'Open Screens' window to begin recording the Logic flow.

5. This will launch the application and the MetaBot Recorder window.

6. Perform actions as required for the Logic.

Note: The MetaBot Recorder window displays the status of the current action being performed.

7. Click on Stop once done. This will launch the Logic Editor wherein you can verify whether all actions are captured or not.

8. Modify if necessary and Save the Logic.

Note: Recorded Screens are added to your Assets library.
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9. Using the Logic Editor
Use Logic Editor to create simple manageable independent navigational flow - Logic that can be integrated into automation tasks as
and when required. Logic is a pre-configured use case of an application that leverages Assets (Screens and Dlls).

The Logic Editor

Use the following components to create a Logic.

1. Run - Use this to run the Logic Block in the Logic Editor view.

2. Save - Save a new or an edited Logic Block

3. Screen - Displays name of the selected screen provided during 'Configuration'.

4. Captured Object - This space displays the captured Assets (Screen or Dll).

5. Previous/Next - Use this to navigate between captured Assets (Screens and Dlls).

6. Show/Hide Assets - A toggle control used to display or hide captured Assets(Screens and Dlls).

/

7. Assets carousel -Displays captured/recorded screens and dlls in the chronology they were added. It invokes on clicking 'Show
Assets'. Offers a visual means to viewing and adding Assets. Use this to select the required Asset to the logic.
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8. Edit button - Use to edit an existing Command or Action.

Note: 'Run', 'Save' and 'Edit' are enabled when an Action/Command is configured.

9. Commands button - Use to add Commands to the Logic Block.

10. Context menu -Use to perform any of the actions given in the list:

11. Variable Manager/Error View - Use the 'Variable Manager' to manage variables and the 'Error View' for viewing and fixing task
errors.

12. Properties Window - Use the floating 'Properties Window' to add and/or update actions.
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Building Logic

A Logic is a combination of 'Commands' and 'Actions'. These, you can add with the help of Commands button.

1. Adding Commands

Combine any of the Commands to build your Logic:

a. Clipboard - Use this to perform certain activities with Windows clipboard.
Learn More

b. Message Box - Use this to insert a message box in the Logic.
Learn More

c. Comment - Use this to provide additional information about the Logic in the form of comments.
Learn More

d. Import Dataset - Use this to automate filling of forms with large amounts of data from a single source.
Learn More

e. If/Else - Use this to add conditional logic and actions to the Logic Block.
Learn More

f. Error Handling - Use this to handle errors while running a Logic, to aid in debugging.
Learn More

g. String Operation - Use this to manipulate a text string or extract part of a string and store it in a variable.
Learn More

h. Variable Operation - Use this to assign variables to the Logic.
Learn More

2. Adding and Updating Actions

To Add and/or Update various 'Actions' to build your Logic, select relevant action in the floating Properties window that appears when
you click on an object.

Tip: You can identify the 'Object Type' and it's 'Play Type' based upon the icon that appears in
the title bar of the Properties window.
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Actions depend upon the Object and Control Type selected for 'Screen' and Class and its API selected for 'DLLs'.

Also, the properties and relevant actions are controlled by the 'Play Mode' that has been selected while configuring the screen.

l To Add an Action, click on the captured Screen/Dll.

Note: Custom objects are highlighted in blue outline.

l Drag the cross-hair to select the precise location where you want to perform an action. Refer screen-shot below:

l To view a list of objects that are neighboring to the selected object, right click. This helps in selecting the precise object control
based on its parent object. Use this option when you are unable to select a particular control on the screen.
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l To add 'Delay' and/or 'Wait for Object to exist option' click on the 'Advanced Options' tab.

Note: 'Delay' option is available on selection of the 'Keystrokes' action as it allows you to
accommodate the time required between firing of two separate keystrokes.

l Also, to view the properties of the captured object, select the option 'Show Object Properties'

Note: The default search criteria are displayed in blue font and can be variablized. To change
the default search criteria for an object, use 'Configure'. Learn More

l To 'Update' an Action, double click on the event data in the Actions List or click the 'Edit' button.
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Note: If the Asset that you navigate to is deleted, you are provided appropriate message.

A. Screen Actions



Copyright © 2017 Automation Anywhere, Inc. P a g e 43 Email: support@automationanywhere.com

Actions that are allowed on HTML Controls:

1. Click/Double Click/Right Click/Left Click

2. SetText/AppendText - Use these when the selected object require firing keystrokes.
Learn More

3. GetProperty - Use this action when you want to search the objects based on their properties during play time. Learn
More

4. GetVisibility - Use this action to build a logic based on a screen area's visibility during play time.
Learn More

5. Wait

6. Drag and Drop

7. GetTotalItems

8. GetSelectedIndex/Text

9. SelectItembyText/Index

10. GetChildrenName/Value

B. DLL Actions

You can use a DLL in your Logic in the Logic Editor just like you would use a Screen.

1. Select a Dll from the Assets carousel (available when you click 'View Assets'). This will list the selected DLL with
classes in the left pane.

2. Expanding your desired DLL will reveal its namespaces and related classes.

3. Select a class from the list. The supported APIs for the selected class are displayed on the right pane.

4. From the list of APIs select the one for which you need to input a value.

Tip: Use an Array type variable to input values if you want to assign multiple val-
ues to a single parameter. Learn More

5. You can also choose to assign the output value to a variable.
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3. Adding and Editing Variables in the Variable Manager

Variables are storage locations for known or unknown information. When building Logic, variables play an important role in main-
taining or calculating information.

l 'Add', 'Edit' or 'Delete' variables from the Variable Manager in the Logic Editor. Learn More

l Also assign System Variables, if required, while configuring the block.

l System Variables - MetaBot Designer provides powerful pre-defined system variables that you can use to automate common pro-
cesses. Learn More
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4. Using the Error View

Use the Error View to manage errors that occur in your Logic Block. Use the Error Handling command to manage those.

Save the Logic.

5. Running the Logic

Click 'Run' when in Logic Editor view. You need to verify whether your Logic runs as required.

Tip: Use ‘Run from this step’ option if you want to skip the earlier steps while during a test
run.
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The Run Time window for a MetaBot appears towards right at the bottom of your screen:

l Click the Pause icon to pause the Logic run:

Tip: Click the Play icon to resume playing the Logic:

l Click the Stop icon to discontinue :

Note: Once you are done creating your Logic, you can upload it to the Control Room for other MetaBot
users. Learn More
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10. Selecting Actions in the Logic Editor
You can select various 'Actions' in the Logic Editor based upon the object and control type selected. Actions are allowed on HTML, .
NET and Java Swing/AWT controls.

Actions allowed on HTML controls

The following Actions are allowed on HTML Controls:

1. Click

2. DoubleClick

3. Right Click

4. Left Click

5. SetText

6. AppendText

7. GetProperty

8. GetVisibility

9. GetTotalItems

10. GetSelectedIndex

11. GetSelectedText

12. SelectItembyText

13. SelectItembyIndex

14. GetChildrenName

15. GetChildrenValue

The next section describes in brief the options available in Set Text, Append Text and Get Property.

1. Get Text, SetText and AppendText

Get Text, SetText and AppendText actions are available when the selected object types are Text/Text Box, Client, Password, Windows
Control or Custom Objects.

While building your Logic, remember that the properties and relevant actions are controlled by the 'Play Type' configured for the selec-
ted Screen.
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l or Action type as 'SetText', you can use keystrokes option to emulate entering text using a keyboard.

Note: In SetText, 'Keystrokes' is selected by default when the Play Type is either 'Image' or
'Coordinate.

l Use virtual keyboard to enter certain special keyboard keystrokes:

l Optionally, select 'Mask' to encrypt the keystrokes.

l Enter the required text in 'Enter Text box'. Optionally, assign a variable to 'Delay'.

l Advanced Options : Provide appropriate 'Delay' between keystrokes in 'Advanced Options'.

Provide 'Wait time for the object to exist' to allow for object load time and ensure the logic does not fail during play time.

If play type is set to 'Image' for the control, you can configure image Match and Tolerance values in percentage.

A Match value defines the extent of overall mismatch allowed between Image1 and Image2; Tolerance defines the extent of mis-
match allowed between any two pixels under comparison.

Similarly, if the play type is set to 'Object' for the control, you can select your OCR engine and configure the Tolerance values in
percentage.
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2. GetProperty

Use the 'Get Property' action when you want to search the objects based on their properties during play time.

When you select action as 'Get Property', you will be able to select properties names such as Object ID, Name, Value, Class, Type,
Index, Description, State, IsVisible, IsProtected etc based on the object control selected.

Tip: Use the 'IsVisible' property to identify whether a specific object is visible or not. For custom
objects, you can achieve this by using the 'GetVisibility' action; refer the next section.

GetVisibility

Use the GetVisibility action to build a logic based on an object's visibility during play time. This screen area could be a custom object or
an object with Play Type Image. The 'GetVisibility' action returns the visibility status as True or False.

To add a 'GetVisibility' action in the Logic Editor, the object should be configured for Play Type 'Image'.

Tip: GetVisibility can be combined with conditional commands such as If.
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Actions allowed on Window Controls

The following Actions are allowed on Window Controls:

1. Click

2. DoubleClick

3. RightClick

4. LeftClick

5. SetText

6. AppendText

7. GetProperty

8. GetChildrenName

9. GetChildrenValue

SetText for Window Control - Use the action type 'SetText' for Window Controls. Select the entire window and specify the action type.

Note: The Window Control for Play Type 'Object' uses keystrokes by default.
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Section 2: MetaBot Designer - Commands
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11. Clipboard Command
Automation Anywhere provides a system variable -$Clipboard$, that you can use to retrieve text that has been copied to the Clipboard.

Use this to perform certain activities with Windows clipboard in the Logic.

Sub-Commands

The Clipboard command provides the following sub-commands:

l Clear Clipboard

l Assign to Clipboard

l Assign from Clipboard

Using the Sub-Commands

To insert a Clipboard command in your task,

1. Open the Logic Block in the Logic Editor.

2. Click on the Commands button.

3. Specify the required parameters in the fields of the Clipboard command window.

4. Save the command to your Logic Block.

Clear Clipboard

Use this command to clear the contents of the Clipboard.

Assign To Clipboard

Use this command to assign the value of any variable that has been created using the Variable Manager to the Clipboard. You can
then access this value by using the $Clipboard$ system variable.
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Assign From Clipboard

Use this command to assign the value contained in the Clipboard to any value type variable that has been created using the Variable
Manager.
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12. Message Box Command
The Message Box command enables you to insert a message box in a Logic Block when you want to display a message to the user
when the task runs. You can specify a custom caption for the message box.

Inserting a message

To insert a message in your Logic Block,

1. Open the Logic Block in the Logic Editor.

2. Click on the Commands button.

3. Specify the following components in a message box:

l Caption: Enter a caption name for your message box.

l Message: Enter your message in the dialog box.

l Scroll bar: Insert a scroll bar in your message. The minimum message length for a scroll bar to be displayed is 10 lines.

l Close Message Box: Enter the seconds value after which the message box should close.

Common Use Case: Message boxes are useful for issuing a message to the user whenever the task concludes running. For example,
when a web form task completes a run, you might issue a message that states: "Web Form Filled and Complete."
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13. Comment Command
Use this command to insert comments in your Logic Block to provide additional information. Comments are ignored when the task
runs.

Comments are useful in annotating the task steps. Some people use comments to extensively document details about their tasks.
Some people use fewer comments just as reminders.

Inserting a Comment

To insert a comment,

1. Open the Logic Block in the Logic Editor.

2. Click on the Commands button.

3. Type your comments in the Comment text box provided.

4. Click Save.

5. A comment is inserted in the Logic Block. You can copy this comment to add multiple comments, or move the comment to another
position simply by dragging it.

The comment is displayed in green in the Actions List, and is always saved as a single line. Multiple-line comments are displayed as a
single line when the comment is saved.

Note: Though a command, a comment line is not executed.

Sample Comments
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14. Import DataSet Command
To automate filling of forms with large amounts of data from a single source such as html pages, use the Import Dataset command that
is available in the Logic Editor.

It enables you to create logic that would otherwise involve numerous keystrokes and clicks. It offers you the flexibility to select controls
and define relevant action at the MetaBot command level.

Note: HTML controls that are identified during data import include text box, radio button, combo
box, check box, and buttons.

How to Import Data

You can auto-fill forms by integrating the Import Dataset command from Logic Editor > Commands.

1. Create a Screen using required application. Learn More

2. Configure the Screen for required parameters. Learn More

Tip: If an object does not display or displays an unidentifiable text and/or number, its recom-

mended you provide an alias to that object during Screen configuration. Learn More

3. In the Logic Editor, select Import Dataset from the Commands list.

4. Start filling in details using a combination of variables, text and controls. Unless a field is populated, you cannot move to the next.

Note: Disabled controls in a form will display grayed out in the Value column.
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Tip: Define an Array type variable to import 'Values' that can be filled multiple times for a

single 'Entry Name'. Learn More

You can use either the direct assignment of variable i.e. assign a Value or indirect assignment i.e. assign value from a text doc-
ument as shown:

For variables that make use of credentials or any sensitive data, use Credential Variables. Select the required variable listed under
$CredentialVariables$ from Insert Variables. Refer the article Assigning Credential Variables for details.

Your logic will reflect the Import Dataset command in the event data.

5. Edit and Save.

Note: To enable editing of Value parameters, select 'Play'.

It is a best practice to Calibrate Screens that are used for Import Dataset command if the application is subject to frequent updates.
These would affect the MetaBot during play.

https://support.automationanywhere.com/hc/en-us/articles/230205168-Assigning-Credential-Variables
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15. If/Else Command
Use this command to add conditional logic and actions to your automated task.

Sub-Commands

The IF/ELSE command provides the following sub-commands:

l Window Exists / Window Does Not Exist

l Variable

l Else If

l Else

l End If

Overview

One of the most powerful features of Automation Anywhere is the IF/ELSE command. You can use the sub-commands to perform
actions when certain conditions exist.

When using most of the conditional sub-commands, you can specify how long to wait for the condition to be true before taking another
action.

Using the Sub-Commands

To insert an IF/ELSE command in your task, follow these steps:

1. Double-click or drag one of the If/Else commands to the Actions List pane. The IF/ELSE window is displayed.

2. Specify the required parameters in the fields.

3. Save the command to your Logic Block.

Window Exists/Window Does Not Exist Sub-Commands

Use these commands to do the following:

l Check or verify that a specific application is open.

l Check whether an error has occurred.

l Check whether a file download has completed.

Note: A window might open in a second or could take longer. To tackle this situation, use the
"Window does not exist" option of If command.
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Variable Sub-Command

This command, though it looks simple, is perhaps the most powerful conditional command. Use this command to perform hundreds of
checks.

For example, you can copy data from an application or website and verify that the data you copied matches a specific text string. You
can also verify a numeric string, or check to see if it is greater than or less than a variable or a fixed value.

Using 'AND' or 'OR' conditions in IF Variable command

When you need to include the 'AND' or 'OR' conditions in conjunction with the 'Variable' sub-command, use the 'Add more conditions'
option. It offers you the luxury of including all your AND or OR conditions within a single parameter, instead of specifying separate para-
meters for each condition

Enable the 'Match Any' option for 'OR' conditions or 'Match All' for 'AND' conditions (refer image below)
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Note: You cannot include both; 'Match Any' + 'Match All' within a parameter. You are required to spe-
cify them within a task, separately.
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16. Error Handling Command
Use this command to handle errors while running a Logic, to aid in debugging.

Overview

By using the Error Handling commands, you can isolate errors that occur when running your Logic.

When an error occurs, you can continue running the Logic or stop.

Sub-Commands

The Error Handling command provides the following sub-commands:

l Begin Error Handling

l End Error Handling

Error Handling Options

MetBot Designer provides the following options for error handling when an error occurs:

1. Take Snapshot: In case of any error, take a snapshot of the screen.

2. Variable Assignment: Specify a value to be assigned to a variable and Set Task Status Pass or Fail depending on the Error hand-
ling action.

This is more useful when one wants to Continue running a Logic, and thus in that case the user wants to set a specific value to a
particular variable.

Use any or all of these options in combination.

When any of the Begin Error Handling option is selected, End Error Handling is automatically inserted in the Logic Editor. However,
one can also specifically select End Error Handling action when the related actions are completed.

You can verify the values of error handling in the 'Error View':
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17. String Operation Command
Use this command to manipulate a text string or extract part of a string and store it in a variable.

For example, use it when you want to extract a portion of a text block from an email, a website, or an application window.

You can also manipulate strings after capturing them. You might search the string for particular phrases, compare two strings, convert a
string to upper or lowercase, or obtain the length of a string.

Sub-Commands

The String Operation command provides the following sub-commands:

l Before/After

l Compare

l Find

l Length

l Lower Case

l Replace

l Reverse

l Sub-String

l Trim

l Upper Case

Using the Sub-Commands

To insert a String Operation command,

1. Open the Logic Block in the Logic Editor.

2. Click on the Commands button.

3. In the String Operation Command, select the relevant sub-command.

4. Specify the required parameters in the fields.

3. Save the command to your Logic Block.

Before/After Command

Use this command to specify a range of text to extract, using Before and After keywords.

You can insert 'Enter' and 'Tab' variables by using the F2 function key. These variables act as separators for your string between the
Before and After keywords.

To refine your 'Before-After' string command, you can use the 'OR' or 'AND' Logical Operators.

l Use the 'AND' operator to ensure 'Before' and the 'After' conditions are met.

n For instance, when you input a string in 'Before' and if not found, the search will be aborted. The program will not search the
string input in 'After'.

l Use the 'OR' operator to ensure either 'Before' or 'After' condition is met.

n For instance, when you input a string in 'Before' and if not found, the program will continue to search for the string input in
'After'.

Note: The default Logical Operator is 'OR'
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Example: In the text string, 'Name of Applicant James Smith Applicant Location,' let's copy only 'James Smith'. We specify Before =
'Applicant' with an Occurrence of 1. We also specify After = 'Applicant' with an Occurrence of 1. This is the first occurrence after the
Before keyword, although it is the second occurrence from the beginning of the string.

You can also specify the number of characters to be extracted, starting from the first character after the Before keyword. The extracted
string can be trimmed to remove leading or trailing spaces, and you can save the string to a variable.

Tip:

l When using the Before/After command, enter a space as a separator between strings using the SPACE BAR
key on the keyboard.

l In some cases, content extracted from websites are separated by an Enter symbol (a small square),
which you can see in the CSV file.

Compare Command

Use this command to compare strings by specifying the strings. You can refine your search by selecting the 'Match Case' option. A
value of True or False is returned. You can assign the values that are returned to a variable.
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Find Command

Use this command to locate a sub-string that exists within the source string by specifying the Start parameter.

If the specified string is a regular expression, select the check box that is provided. Insert the regular expression in the Find String field.
Also, refine your search parameters by specifying the line number in 'Start From', selecting 'Match Case' and/or Regular Expression.

For example, to find all email addresses in the source, specify the following as a regular expression: \b[A-Z0-9._%-]+@[A-Z0-
9.-]+\.[A-Z]{2,4}\b

Length Command

Use this command to obtain the length of a string by specifying the source string.

Lower Case Command

Use this command to convert a source string to lower case .
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Replace Command

Use this command to replace a portion of a source string with a specified replacement string. Optionally specify the character position
from which to begin in 'Start' and the number of times it is to be replaced in 'Count'. If the Find String field contains a regular expression,
select the Regular Expression check box.

Reverse Command

Use this command to reverse a specified source string.

Sub String Command

Use this command to retrieve a sub-string. Specify the source string and parameters such as 'Start From' and optionally 'Length'.
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Trim Command

Use this command to trim blanks and spaces from a specified source string.

Upper Case Command

Use this command to convert a source string to upper case.
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18. Variable Operation Command
Use the Variable Operation command to assign user specified variables (user variables) in a Logic Block.

The type and source of variables used dictate the assignment. These are applicable during task execution thus allowing the user to
reuse the user variables.

Using the Variable Operation Command

To use the Variable Operation command,

1. Open the Logic Block in the Logic Editor.

2. Click on the Commands button.

3. Select either User Variables or System Variables.

l Assigning User Variables:

a. Select a user variable to specify a value to an existing user variable that you have defined.

b. Assign a value. You can assign a value to the variable. The right side of the 'equal to' operator can be a regular operation;
for example, you can specify: $var1$ = ($var2$ + $var5$ - 10) / 5.

Note: The operators (, ), /, *, + and - are supported. The left and right parentheses
take precedence, and the operation within them is evaluated from left to right.

Example: In the expression ($Var1$ + 5) * ($Var2$ -10), the first calculation ($Var1$ + 5) will be evaluated
first, then ($Var2$ -10), and the result of both will be multiplied and assigned to the variable specified on the left side
of the equals sign.
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l Assigning System Variables:

This option enables you to reset one of the following system variables:

a. Error Description

b. Error Line Number
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Section 3: MetaBot Designer - Variables
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19. Adding, Editing and Deleting Variables
Variables are storage locations for known or unknown information.

When building Logic, variables play an important role in maintaining or calculating information. Variables can help you in a number of
ways, from fetching online data to transferring data between applications.

Automation Anywhere is designed with various types of variables which can be defined for each Logic.

These are known as local variables. It has pre-defined system variables available for all tasks.

Some commands, like String Operations, provide a navigation for you to select and insert variables in your task.

Adding Variables to a Task

You can use the F2 function key to list all user and system variables that are available for insertion.

Note: You can create 'Value' and 'Password' type variables in Logic.

Variable Types

1. Value - You can use a value type variable when you need to hold a single data point and use it in multiple places. This "place-
holder" value can represent either text or numeric data.

After you create the variable, you can use it by inserting the variable in several of the Logic Editor commands. When the value of
the variable is modified, this value is reflected in any subsequent commands.

You can also mark a value type variable as 'Regular Expression' . These, you can use when creating tasks that require pattern
based searches in files, folders and window title commands.

2. Password - You can use a password type variable when you specifically need to hold the data as a "Password". This value is
encrypted by default.



Copyright © 2017 Automation Anywhere, Inc. P a g e 71 Email: support@automationanywhere.com

3. Array - Use an Array type variable for creating staging areas for data that need to be retrieved by your process as it runs. It is a two-
dimensional variable that holds multiple values in a table of rows and columns.

Assign Array Type variables to your Screens and Dlls via commands and/ or values.

Note: MetaBot Designer supports Array type variables as 'Value' and 'Read from Text File'.

Parameter Types

You can select any of the following to assign as a parameter while designing your logic:

None - This is the local variable which will not be exposed for use in tasks once the logic is uploaded.

Input - This variable allows inputting values in the Logic.

Output - This variable allows outputting values in the Logic.

InputOutput - This variable allows both - inputting and outputting of values in the Logic.

Editing a Variable

You can edit and modify any local variable that you have created. In addition, you can edit the pre-defined variables.

To edit a variable, follow these steps:

1. Select the variable you want to edit.

2. Click the Edit button or right-click on the variable and select Edit. The Edit Variable window is displayed.

3. Modify the variable fields as necessary. You can change the variable type, the name, or the method of determining value.

4. Click Save.
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Deleting a Variable

To delete a variable, use the Variable Manager.

For instance if you 'Copy All' variables to another Logic, you might need to delete several variables that are redundant in the new nav-
igational flow.

To delete a variable,

1. Select the variable you want to delete.

2. Click the Delete button or right-click on the variable and select Delete.

3. When the confirmation message is displayed, click yes.

Note: You can delete variables one at a time.
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20. System Variables
Automation Anywhere provides powerful pre-defined system variables that you can use to design Logic Blocks.

Note: Though similar, not to be confused with System Variables available in Task Editor.

System Variable types that can be used in the Logic Block include:

l Date/Time: System-related date and time variables.

l Error Handling: Error Handling related variables.

l System: Variables specific to a particular client machine.

Date/Time System Variables

You can use the set of Date and Time system variables to insert or monitor the current date and time of a system as the navigational
flow is implemented.

Tip: You can change the date format for the System Date.
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Click to change the date format:

Error Handling Variables

Use the set of Error Handling system variables to return task error line number and description.

System Type System Variables

You can use 'System' variables to include parameters in your automation task that are related to a particular computer. The variables
return actual system settings and parameters, such as RAM, CPU/RAM usage, and total RAM.

Common Use Case: These variables are useful when the performance of a system needs to be tracked during an activity; for instance
load testing.

The following table provides names, return values, and descriptions for the system-related system variables.

*When you select the System variable, a menu is displayed from which you can select the specific system variable (see steps below).
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Steps to select System from Variables:

1. Click F2 and you will see Insert Variable window.

2. Select System and click Insert; a pop up window for System Variable Option appears.

3. Click OK and insert the System Variable.
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21. Variables - Parameter Types
MetaBot Designer uses Value Type variables by default. You can also define the parameters for the variables that you add. Para-
metrize variables for local use, to be only read from, to be set to or read as well set while designing your Logic Blocks.

Parameter Types

You can select any of the following to assign as a parameter while designing your logic:

You can select any of the following to assign as a parameter while designing your logic:

1. None - This is the local variable which will not be exposed for use in tasks once the logic is uploaded.

2. Input - This variable allows inputting values in the Logic.

3. Output - This variable allows outputting values in the Logic.

4. InputOutput - This variable allows both - inputting and outputting of values in the Logic.

You can use these when you want flexibility when assigning variables. Also assign 'Fixed' and 'Variable' values to this parameter in
tasks.
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22. Using Array Type Variables
An array variable is a two-dimensional variable that holds multiple values in a table of rows and columns. Arrays are very powerful for
creating staging areas for data that need to be retrieved by your process as it runs.

Common uses of array variables include:

l Extracting data from web pages

l Extracting many rows of data from an Excel spreadsheet or a database

l Read or write data from/to a legacy system, an ERP system, or another application

l Filling out order forms with different fields from Excel to Database

The values can represent either text or numeric data.

After you create the variable, you can use it by inserting the variable in several of the MetaBot commands.

When the value of the variable is modified, this value is reflected in any subsequent commands that are run by the task.

Creating an Array Type Variable

You can create an array type variable in one of two ways:

l Using direct assignment

l Using a text file

Direct Assignment

When the values of an array variable need to be defined directly, you can opt to use 'Value' Array type variable. This is termed as 'Dir-
ect Assignment'.

To create an array type variable using direct assignment, follow these steps:

1. In the Logic Editor, click on the Variable Manager tab on the right side.

2. Click on the Add button. The 'Add Variable' window is displayed.

3. Select type 'Array'.

4. Enter a name for the variable. The name must begin with an alphabet and should not contain spaces.

5. Select how you want the array to be created. Default selection is 'Value' which indicates that you will define the values of this vari-
able directly in it. .



Copyright © 2017 Automation Anywhere, Inc. P a g e 78 Email: support@automationanywhere.com

6. Specify the number of rows and columns in the field provided. Default values are 1 X 1.

7. Click the Initialize Values button. The Array Value Details window is displayed based on the rows and columns provided in step 6.

8. Enter the values for each cell.

Tip: You can modify the array dimensions using the Add Row, Add Column, Delete Row, and Delete
Column buttons.

9. Click the Save button to save the values.

10. Click the Save button in the Add Variable window to save the Array variable.

After the variable is saved, it is displayed in the Local Variables section of the Variable Manager.
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If you don’t want to specify the value of the variable at the time you create the variable, MetaBot Designer allows you to set the values
of variables using a text file. This is described in the next section.

Reading from a Text File

Create an array type variable using text file assignment when you want to read values from a specified text file into the array variable
while the task is running. The text file is used to define the array variable.

To create an array type variable using text file assignment, follow these steps:

1. Determine the text file that you will use for assigning values.

l For Rows enter the data in a new line.

l For Columns use comma separated values.

l Example: sports_team.txt

2. In the Task Editor, click on the Variable Manager tab on the right side.
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3. Click on the Add button. The 'Add Variable' window is displayed.

4. Select type 'Array'.

5. Enter a name for the variable. The name must begin with an alphabet character and should not contain spaces.

6. Select 'Read from text file' from the list.

7. In the Select File field, browse to the file or type the file path for the required text file. Use the Open File button to view the selected
text file or to modify it.

8. Click Save.

Inserting Array Variables in Screens and DLLs

You can insert Array Variables while creating Logic in the Logic Editor. It can be used to assign values in Screens and/or Dlls.

Tip: You can insert rows and columns in MetaBot Commands for a Screen. However, when used with a
DLL, you can insert only a single column to the Array type variable during assignment.

1. Adding an Array variable to a Screen - You can add an Array variable in Screens via MetaBot commands; namely Message Box,
String Operation, and Variable Operation. You can also assign a variable in the Screen directly in the property window as shown:
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2. Adding an Array variable to a Dll - You can insert an Array variable while inputting values by pressing the function key 'F2' as
shown:
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Section 4: MetaBot in Enterprise Control Room
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23. Uploading MetaBots to Control Room
MetaBots can be uploaded to the Control Room from where any number of Bot Creator Clients with MetaBot license can download and
integrate them within automation tasks.

1. In the My MetaBots List, select (highlight) the MetaBot you want to upload.

2. Upload the Metabot using one of the following methods:

l In the Actions button, select Upload from the drop-down list.

l Context click the MetaBot and select Upload.

l Go to Repository in Manager, select the MetaBot, and click on Upload.
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Tip: Ensure the MetaBot is closed in the MetaBot Designer Client. Also, note that if the
corresponding MetaBot is the only MetaBot that is opened in the MetaBot Designer while
uploading, you need to exit from the MetaBot Designer Client.

Uploading MetaBots when Version Control is Enabled

When Version Control is enabled, you can upload a MetaBot to the Control Room repository with comments, after using the 'Edit'
option.

1. In the 'My MetaBots' List, select (highlight) the MetaBot you want to Edit and Upload.

2. Edit the Metabot using one of the following methods:

l In the Actions button, select Upload from the drop-down list.

l Context click the MetaBot and select Upload.

l This launches the Upload Comment window:

l Input your comments and click Save. This uploads the MetaBot to the Control Room.

Uploading Multiple MetaBots

1. Go to Manage > Repository.

2. Select the My MetaBots folder in the Client Repository list.
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3. Select multiple MetaBots (use either ctrl or shift keys as required).

4. Click the Upload button.

5. In the Upload Files window, the MetaBots that are 'Allowed' to be uploaded are selected; if required, deselect the ones that you do
not want to upload.

Tip: No prefixed icon/sign denotes a successful upload. This ensures that the version history
can be used as a reference point by the Client.

Note: MetaBots marked 'Not Allowed' cannot be uploaded; the reason for which is depicted in
the 'Remarks' column.

6. Add your 'Upload Comments' and click 'Upload'. These comments are applicable to all MetaBots that are uploaded.

Uploading Renamed MetaBots

MetaBots that are already present in the Control Room repository and are renamed from a file system cannot be reuploaded to the Con-
trol Room repository. If you attempt to upload such a MetaBot from the Client, following message appears:
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When you upload the renamed MetaBot(s) from the Repository, following messages appear:

l For a MetaBot:

l For multiple MetaBots:

You will have to revert to its original name in order to upload it.
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24. Creating Roles and Assigning Permissions for MetaBots
You can define user roles and assign the necessary permissions for using MetaBot Designer in the web based Control Room from the
Security console.

Creating New Roles

To define new user roles, click on 'Create New Roles'.

In the 'Create New' roles page, input the role name:
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You can also assign permissions based on the role you wish the user to play.

Note: MetaBot Designer users require a separate set of privileges to access the MetaBot files.
Hence, the Control Room admin has to grant separate MetaBot Repository access rights at MetaBot file
level, apart from the 'Repository Manager folder rights.

Access Permissions for MetaBots Users

To grant privileges such as Execute, Upload, Download, and Delete, click the MetaBots Manager tab beside the Repository Manager
tab in the Access Rights panel. You can grant access privileges to a user at each MetaBot file level.

1. Execute - User can use the Metabot in TaskBots but is not allowed to open the downloaded MetaBot in MetaBots Designer. This
allows sharing of MetaBot as a Black-boxed bot. User cannot see/modify the content of a MetaBot.

2. Upload - User can upload MetaBots.

3. Download - User can download and modify MetaBots.

4. Delete - User can delete the downloaded MetaBots.
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 Note: If you grant 'Download' permission to a user, the 'Execute' permission is automatically
enabled so that a user can choose to either view/edit the content of a MetaBot that is downloaded or
not all i.e. use it as a black-box.

You can choose to provide access rights based on the role that the user is allotted.

E.g. A BotCreator Client who has access to MetaBot Designer can be granted all permissions whereas a BotRunner Client with
MetaBots license can be granted only the 'Execute' permission.

Managing the User

You can verify whether the User has been created in the list in 'Roles and Permissions'.

To return click on .

Note: To edit the User roles and permissions, click on . To delete the User click on .
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Section 5: MetaBot in Enterprise Client
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25. Enabling Version Control
The MetaBot Designer has an integrated feature on Version Control that allows MetaBot users to manage various versions of
MetaBots and enforce controlled edits.

 Note: Automation Anywhere supports Subversion v1.8.13 and v1.8.14 with Visual SVN Server 3.3.x

(Image as seen in Enterprise Client - MetaBot Designer version 10.3)

Control the versioning of MetaBots in Clients by enabling the feature from Automation Anywhere Enterprise Control Room.

Learn More

Using Version Control in MetaBot

To perform controlled edits to your MetaBots, use versioning to create new files, check out for edit, upload with comments and view the
version history.

You can context click the MetaBot in the 'My MetaBots' list view of the Automation Anywhere Enterprise Client.

You can also perform similar operations using Actions.

https://support.automationanywhere.com/hc/en-us/articles/230204128-Version-Control-Integration
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Tip: Ensure the MetaBot is closed in the MetaBot Designer Client. Also, note that if the cor-
responding MetaBot is the only MetaBot that is opened in the MetaBot Designer while performing these
operations, you need to exit from the MetaBot Designer Client. 

Perform the operations detailed below using either context click or 'Actions'.

1. Edit: You can edit a MetaBot from the 'My MetaBots list' provided it has been 'Uploaded' and 'Checked Out'. On editing, you are
guided to the 'Assets' view of the selected MetaBot in the MetaBot Designer. Here, you can opt to add/record screens, dll's, and
add/update Logic(s).

A new MetaBot created in the local repository (of the Client) has a plus sign ( ) appended to the MetaBot name.
Refer the article on 'Creating a MetaBot' to learn how to create a new MetaBot.

2. Check Out: A MetaBot that already exists in the Control Room repository can be checked out for editing. A check mark (
) indicates the file is checked out for editing.

The option toggles to 'Undo Checkout' once the MetaBot is checked out for editing. This enables you to undo the last update(s) to
the checked out file. Select 'Yes' to confirm:

3. Upload: Post editing, you can upload a MetaBot to the Control Room repository with comments. No prefixed icon/sign denotes a
successful upload. This ensures that the version history can be used as a reference point by the Client.

You can also opt to upload MetaBot(s) from the My MetaBots folder in the Repository.
Learn More
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4. Version History: You can view revisions to a MetaBot and if required, roll back any updates. It allows you to identify the user and rel-
evant 'Action' that was performed during a specific 'Date and time' with relevant check in 'Comments'. Learn More

5. Rename: You can rename a selected MetaBot in the local repository provided it has not been checked out. Note that if you rename
a MetaBot and upload to the repository, it will overwrite the existing MetaBot with the previous name. The version history will be lost
in such case. Learn More

6. Locate on Disk: In some cases, you might want to locate the MetaBot that is associated with an automated task you've created.

Automation Anywhere MetaBot files have the file extension of: '.mbot'

To locate a MetaBot on your computer, follow these steps:

1. In the main Automation Anywhere window, select the MetaBot in the My MetaBots List for which you want to locate the
.mbot file.

2. Either click on the Edit menu or on the Actions button, and select 'Locate on Disk'. The MetaBot files are listed in
the File Explorer.

3. Locate the automation MetaBot file. The .mbot name matches the name you've assigned to the MetaBot.

7. Delete: You can delete a MetaBot from the local repository provided it has not been checked out. Learn More
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26. Viewing Version History
Use Version History to view the history of updates to the selected MetaBot. Also roll back updates, if required.

On selecting Version History, you will be able to view a list of all revisions created for the selected MetaBot.

Viewing history of file versions

You can view 'Version History' of the selected MetaBot from:

1. The Context Menu:

OR

2. Actions list:

3. On selecting Version History, you will be able to view versioning details for the selected MetaBot:

The Version History is displayed in descending order of the time-stamp i.e. the latest revision at the top and the first revision at
the bottom. It allows you to identify the user and relevant 'Action' that was performed during a specific 'Date and time' with rel-
evant check in 'Comments'.

Rollback Updates
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You can also rollback the updates to a specific revision. Use this to revert updates/changes in the selected MetaBot to the selected revi-
sion from the version history.

Tip: Ensure MetaBot Designer client is closed before using Rollback.

Select the revision to which you want the updates to be rolled back and confirm:

On confirming, all the changes done since the selected revision to the latest revision will be rolled back and a success message is dis-
played:

 Note: It is recommended you check in (upload) the file once it is rolled back to the selected revi-
sion so that the latest revision(s) are reflected in the updates.
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27. Using MetaBot Logic in Task
You can integrate the pre-configured Logic blocks created using the MetaBot Designer in your automation tasks in the Automation Any-
where Enterprise Editor.

Adding MetaBot Logic to a Task

1. To begin, click on the MetaBot section given at the top of the command panel at the left in the Task Editor.

2. Double click/drag and drop a MetaBot from the list of MetaBots.

3. The MetaBot window is invoked.

4. Select the desired logic from the list. If this logic needs certain input/output parameters, they get listed on the right pane. Otherwise,
the parameter tables appear empty.

Tip: Use the 'Search Logic' facility under Process Logics to navigate to the Logic you want.

5. If you have assigned variables in the logic, you will have to assign the required set of values to the Input and Output Parameters.
You cannot leave these blank.

You can also assign variables to the Input and/or Output Parameters from the list of variables available in the task.

Tip: If the Input and/or Output parameters require use of credentials or sensitive data, you
can opt to use 'Credential Variables'. Select the required variable listed under $Cre-
dentialVariables$ from Insert Variables.
Refer the article Assigning Credential Variables for details.

https://support.automationanywhere.com/hc/en-us/articles/230205168-Assigning-Credential-Variables
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6. Once you are done, click Save to include the MetaBot Logic in your task.

Note: During play time, if your target application is open in admin mode, you will have to run the
task in admin mode.

The Task Editor depicts the event data for Logic:
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